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Console gives you the ability to manage and redirect phone calls for users in your organization from one 
easy to use application on your PC.  

 

 

1. Double-click the Console shortcut icon on your PC Desktop. 

2. Enter your full name into the Login Name field. You may notice that your name displays 
automatically after you enter a few letters. 

3. Enter your PIN number into the PIN field. Initially your PIN will be 2222 until you change it to a 
unique number. 

4. Remember Me … checkbox saves your name for the next time you start Console. 

Note: Your default start-up PIN will be 2222 until a new PIN is created. 

1. In the menu bar, click File > Change PIN... 

2. Enter the Old PIN. (default = 2222) 

3. Enter the New PIN. 

4. Enter Verify New PIN. 

Note: Remember to enter your new PIN the next time you open Console. 

When exiting Console remember to first log out of the Operator queues using the Logout of Queues 

button . 
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The main Console screen is divided into several sections or panes. These panes help you to see current 
calls and call history at a glance.  

 

 
Taskbar and Menu enable the operator to set the queue mode and their breaks. 

 
Active Call and Default Action pane shows information about the current call including Caller 
ID, Phonebook information, and any previous handling. The Default Action is linked to the 
Enter key on your keyboard. 

 
Calls Waiting pane shows a list of unanswered and recalling calls, as well as dial Operator 
calls from Voicemail. 

 
Parked Calls pane shows all calls currently parked at any extension. Separate lists show calls 
parked by operators and calls parked from phones or Voicemail. 

 
Destination pane is used to enter a name or number to call, or to transfer the current call to. 
Shows Phonebook information and the currently active Profile (for Voicemail users). 

 
Additional Functions pane provides tabbed functional screens with additional functionality: 

 Presence functions/buttons to view extension status at a glance and route calls to the 
extension or voicemail. 

 Call History to view recent call details. 

 Message information to manage voicemail and fax messages for company 
mailboxes. 

 a Web browser 

 Quick Find to quickly see a list of phonebook entries matching a partial entry in the 
Destination field 

 Desk-to-desk Chat to respond textually to information requests from other users. 

 
The Speedbar provides quick mouse access and keyboard shortcuts to available options for 
the current call. 
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The main button in Console is the default action button. It allows you to quickly perform the most common 
action for the current call or other activity. You can perform the action by clicking the button with the 
mouse, or by simply pressing Enter on your PC keyboard. 

In the image below, three examples are shown – Deliver; Answer; Hangup Call. 

 

The speedbar can be used to perform the active call functions using either the mouse or the keyboard. 
Use the View menu to select the desired format of the Speedbar.  

 

You can also use the Enter key and function keys (F1 to F12) to perform any of the active Speedbar 
functions. When Console is not active, you can use global hot keys to perform some actions. 

Console hot keys are active when Console is the active application. 

Global hot keys can be used when Console is open but not the active active application. Global Hot Keys 
can be enabled using the File>Preferences>General menu. Use the Console hot key simultaneously with 

the   Windows Key on your keyboard. 
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Console Function Console 

Hot Key 

Global  

Hot Key 

Function Description 

Answer Call F2  WIN +F2 Answers a call ringing at your phone. 

Bring to Front  WIN + F12 Brings Console into focus. 

Deliver Call F9  WIN + F9 Delivers the call at the top of the Calls Waiting queue (or the 

specific call that you have selected) to your telephone; the call is 

then displayed in the Incoming Call field. 

Dial F4   Dials the destination displayed in the Destination field. 

[Destination] Cancel F11   While transferring a call, or toggling, allows you to disconnect the 

party you are currently in conversation with, connecting you 

automatically to the held party. 

Exit Alt + F4   Closes Console (this is a standard Windows command to close the 

active application). 

Hang Up Call F3  WIN + F3 Hangs up a call on your phone. 

Help F1   Opens the Online Help screen. 

Park Call F5 WIN + F5 Parks the call. 

Unpark Call F5  Retrieves the parked call. 

Hold Call F6 WIN + F6 Places the call on hold. 

Unhold Call F6 WIN + F6 Unholds the call. 

Add Notes to Call Ctrl + I  Opens a dialog that allows you to enter text notes for a call. These 

notes will be visible to other Console or Desktop users if they 

receive the call (either in the info/notes area, or in a tooltip for the 

call). 

Login/Logout Ctrl + L   Opens the Queue Login screen. 

If you are logged in to queues, logs you out. 

Make Call F4   Makes a call to a selected number. 

Record/Stop Record 

Conversation 

F8   Records a conversation in progress into your voice mailbox. 

Swap Held Call F10   Holds the party you are speaking with, and connects you instead to 

the party you were holding (while transferring a call, or toggling two 

calls). 

Transfer F4   Holds the active call while dialing the number displayed in the 

Destination field. 

Voice Messaging F7   Calls Voice Messaging. This key transfers a call ringing OR in 

conversation at your phone to any mailbox. 
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This pane shows information about the current connected call. 

 

 
Call type and connect time 

 

Caller's phone number, and CLI information from the Phonebook if available, such as person's 
name and company name.  

 

Previous call handling, and any additional notes from the Phonebook or entered for this call with 
Ctrl+I 

 
Default Action, linked to the Enter key on the keyboard. 

 

The Phone Status Icon at the top left of this pane displays the status of the operator's phone at a glance: 

 

 No call – the operator's extension is currently idle.  

 (Yellow) A queue delivered call is currently ringing on the extension. The caller dialed 
the number for your company, or another general number. 

 (Green) A non-queue call is currently ringing on the extension. The caller dialed the 
operator's telephone or extension number directly. 

 (Pink) The operator has dialed a number and is waiting for answer. 

 (Yellow) A call is in progress that was delivered by the queue.  

 (Green) A non-queue call is in progress.  

 (Pink) An outbound call dialled by the operator is in progress. 

 The operator has parked this call using the personal park function at the extension (not 
the Console <F6> Hold function). 

 Another party has put this call on hold. 
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Calls Waiting are calls that have not yet been 
answered by the Operator. The list of calls 
scrolls if necessary so that all calls waiting 
can be viewed. 

 

 

Number of calls waiting to be  
answered. 

 
The time that the oldest call has been waiting in the queue 

 
Call priority (shown as a colored dot) and indial identifier (number called) if any 

 
Caller information (CLI or phonebook details of the contact) 

 

Call type, or reason call is in the queue. Types include: 

 Forward: Calls forwarded from unanswered, unavailable or busy extensions (additional 
information is given in the Special Info field). 

 Recall: Unanswered or held calls recalled to the Operator 

 Consult: Calls in the process of being transferred internally to the Operator (the 
transferring extension has not hung up). 

 VM Transfer: The caller has selected a <transfer to operator> one touch key from a 
mailbox (Special Info shows the mailbox name the caller has been transferred from). 

 Assist: An internal user has dialled the operator queue (different to Consult where the 
caller does not have anyone on Hold pending transfer) 

 Direct: Direct or new call that has not been previously handled by the system. 

 
Additional info such as the internal call source and any notes from the Phonebook. 

The Parked Calls pane shows all calls currently 
parked at any extensions. Separate lists show 
parked calls and transferred calls waiting for 
pickup.  You can pickup any parked call by 
double-clicking on it 

 

 
Number of calls parked and longest park 

 
Caller ID and type of parked call (person for your calls, globe for others' calls) 

 
Person the call is parked for (or park slot) 

 
More info about the call, such as the person who parked it 

 
Calls below the line have been transferred but not yet answered by the new party.  
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The Destination pane enables you to enter 
a name or number to call or transfer the 
current call to.  The field shows 
Phonebook information and the currently 
active presence profile (for Voicemail 
users). 

The Destination field auto-completes with the default number from the Phonebook.  Click the drop-down 
arrow to see other numbers for this contact 

The Info/Notes area shows Phonebook information and the currently active profile (for voice messaging 
users) 

This pane contains six tabbed screens that provide additional useful functionality. 

 Presence Tab: Presence pages and buttons to provide a visual indication of extension and 
Presence profile status and can be used for managing calls. 

 Call History Tab: displays a running history of calls made or received from Console. 

 Messages Tab: view and manage fax and voicemail messages and mailbox settings. 

 Web Browser Tab: a simple web browser is embedded within Console. 

 Quick Find Tab: enables you to locate, select and dial contacts, based on a partial entry in the 
Destination field. 

 Chat tab: provides desk-to-desk text chat between users at a site. 

 

There are two types of Presence buttons: 

 External (telephone numbers outside your office) 

 

 Internal (in-house extension numbers) 

 

Internal Presence buttons enable you to view the user’s extension status by viewing icons and the status 
tool tip. You can also perform advanced call functions for an extension using the right-click popup menu. 
The user’s name displays in mustard text if they are logged into queues as an agent. 

 

Click the phone status icon to display additional contact numbers. 
Click the number you wish to call. 
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Right-click on the Presence button to display the pop-up 
menu. 

 

Note: The actual options available will depend on the 
type of PBX being used, how the system is setup and 
your enabled security permissions. Certain options will 
also only be visible when there is an active call on your 
extension. 

 

 Call ‘user’ on extension Initiate a call to the user on the designated telephone number. 

 
Supervised Transfer 
to ‘user’ 

Transfers your Active Call to the user’s extension and enables 
you to talk to the user before completing the transfer. 

 
Blind Transfer to ‘user’ Transfers your Active Call to the user’s extension. 

 
Transfer Call Transfers your Active Call to the user’s extension. 

 Park for ‘user’ 
Holds your Active Call at the user’s extension; the user can then 
retrieve the call. 

 Advanced Park Parks your Active Call and pages the user. 

 
Notify me when  
user’ is back 

A screen-pop will inform you when the user is in the office and 
available to take your call. 

 Forward all Calls Forwards all your call to a specified internal or external number. 

 
Leave a Voice Message Record a Voice Message for the recipient. 

 Ask ‘user’ to call me back The user will receive a pop-up call-back request on their return. 

 
Transfer to Mailbox Transfers your Active Call to the user’s Voicemail mailbox. 

 
Record Conversation 
to Mailbox 

The conversation is saved to the current user’s mailbox (if 
installed). 

 
Send Message to  
digital Phone 

Send a short text message to the LCD screen of the user’s digital 
phone. 

 Select Presence Profile Change the user’s Presence profile. 

 Rename Rename the Presence button.  

 Delete Delete the Presence button. 

Phone Call Types 

 (Gray) Extension is idle 

 (Various colors) Extension is ringing or 'offering' 

 (Various colors) Extension busy (on the phone) 

 Extension is forwarded to another number (internal or external) 

 Forwarded to Voicemail 

 (Green) Inbound non-queue call 
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 (Pink) Outbound non-queue call 

 (Yellow) Inbound queue call (if queuing is installed) 

 (Blue) Outbound queue call (if queuing is installed) 

 

Profiles 

 In the Office 

 In a Meeting 

 Out of the Office 

 On Vacation 

 (Gray Head) Agent is logged in to queues 

 

Voicemail Status 

 No messages 

 1 or more ordinary messages 

 1 or more urgent messages 

Your Estimated Time of Return (ETR) can be set for those 
Presence profiles used when you are not available. Selecting 
one of these profiles will automatically display the ETR window. 

Note: Setting of ETR can be skipped unless ETR is set as 
mandatory in the system settings. 

1. Select your date of return using the calendar function. 

2. Select your approximate time of return using the standard 
times in the left panel or by setting the time using the clock 
function. 

3. Click OK to save the ETR and activate the selected 
Presence Profile. 

The Add Presence Page wizard can be used to create either Standard or Dynamic Presence Pages. A 
Dynamic Presence Page lists the contacts for a company or department automatically, while contacts on 
a Standard Presence Page are added and arranged manually. 

Note: Only Users with System Administrator rights can add or edit Global Presence Pages. 

1. To start the Add Presence Page wizard: 

 select Add new Presence Page on the File menu, or 

 right-click in the Presence pane and select Add a Personal Presence Page. 

2. Select the Create Personal Presence Page option.  Only administrators can create global pages. 

3. Select the type of page to be created. 

Standard Page Presence buttons must be added and arranged manually. 

Automatic Page Presence buttons are automatically added and updated for the selected 
company/department. 

4. Create Standard page: 
Type a name for your Presence page; go to step 10. 
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5. Create Automatic Page: 
Select a company from the listed companies. 

6. Optionally select to list all contacts or only contacts from selected departments. 
Note: This step is only displayed if departments have been defined. 

7. Select the department(s) to display if the department option was selected in step 6 and click Next. 

8. Optionally click the checkbox and specify the number of buttons per page. 
This defines a maximum number of Presence buttons per page and automatically creates an 
additional page when this maximum is reached. 

9. Enter a name for your Presence page and click Next. 

10. Verify the settings and click Finish to create the Presence Page. 

1. Select Rename this Page from the File menu, or 
right-click in the Presence page and select Rename this Page from the pop-up menu. 

2. Type in the new name for the page and click OK. 

1. Open the page you want to delete and right-click on any blank area. Select Delete This Page from 
the pop-up menu.  

2. Click Yes to confirm the deletion when prompted. 

1. Right-click on the Presence page and select the Add a Presence button option. 

2. Select either the contact name or the contact number and click OK to create a Presence button. 
Note: You can also simply drag a contact name or number from the phonebook to the Presence 
page to create a Presence button. 

1. Right-click on the Presence button and from the pop-up menu, select Delete. 

Select and set your Presence Profile from the: 

 

1. Presence Profiles tab of a User’s Mailbox Settings, or 

 

 

 

 

 

 

2. Presence button (right-click). 
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The Call History Tab displays a running history of calls made or received from Console. The Recent Calls 
listing is automatically cleared whenever Console is shut down. 

The Call History indicates the call direction (incoming: , outgoing: , incoming queue calls: ); ID of 
incoming calls (CLI); date of call; time commenced; and call duration. The exclamation mark icon:  
indicates a missed call.  

Right click on the call record to be deleted and select the Delete Calls option from the pop-up menu. 
Multiple call records can be selected by holding down CTRL and left clicking on each call. All calls can be 
selected by pressing CTRL + A. 

 

The Messages tab enabes the operator to view and manage fax and voicemail messages and mailbox 
settings for their own personal mailbox and for selected company mailboxes. 

 

 

Select a mailbox to view. 
You can view your personal mailbox and any system mailboxes. You can edit the properties of 

the selected mailbox by clicking the Mailbox Properties icon . 

 

Messages in the selected mailbox are shown in the main pane. 
Double-click to open the message. Right-click a message to delete it, or mark it as unread or 
saved. 

 

Mailboxes on the system are shown in the right pane. Personal mailboxes are shown with a 
person icon, and company mailboxes are shown with a world icon. You can move a message 
from the main pane to a mailbox in the right pane by dragging it. 

 

When you open a voice message, the properties display (to open, right-click and select "Play 
message"). 

 

You can play the message through the PC speaker or the phone. 

 

Click Save to save the message to a .WAV file on your PC. 
You can play this file using Windows Media Player or other multimedia applications. 
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Console includes a simple Web browser. This browser allows you to send and receive URLs within desk-
to-desk Chat calls with other users (running Console or Desktop). Most of the basic settings of the 
browser come from the Internet Explorer settings of the Windows user and workstation.  

Quick Find enables you to search, select and dial contacts, based on a partial entry in the Destination 
field. The search results are limited to a maximum of 10 matching entries. To use Quick Find, click the 
Quick Find tab in the Additional Information area. 

Note: If the Quick Find tab is not present, you can enable it from the General tab of Preferences. 

 

 

Type the first few letters of the party's name in the Destination field. Quick Find provides a list of 
matching names. 

 

The Quick Find results show up to 10 matching names, with phone status, profile, and special 
info.  
You can select an entry in the list using Hot Keys Ctrl+1, Ctrl+2... Ctrl+0. Selecting an entry 
places it in the Destination field. 
You can dial an entry using Hot Keys Ctrl+Shift+1, Ctrl+Shift+2... Ctrl+Shift+0 
Note 
You must use the main keyboard for Ctrl+Shift functions (the number pad does not allow these 
functions). 

 

You can right-click a contact for additional options such as to call the extension, leave a 
voicemail message, record into the mailbox, send a message to the Digital Phone display, 
change Mailbox profile or create a Speed-dial. On an active call, the right-click option allows you 
to transfer, park, or place the call on hold.  
Note 
Not all of these options are available for external contacts. 

 

If a contact has more than one phone number, left-click the phone icon to see a list of numbers. 

 

For internal contacts with mailbox profiles, the profile displays. Left-click the profile to select a 
different profile for the user. 
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The Chat function 
enables desk-to-desk 
text chat between site 
users and is a good 
way of exchanging 
information in real 
time and saving a 
transcipt record. A 
Web site URL or the 
sequence of URLs 
can be automatically 
sent to the other chat 
participant as you 
browse. You can have 
more than one Chat 
conversation open at 
a time. 

Click on the Chat tab 
in the Phone bar to 
open the Chat screen. 

 

 Click to start a new chat call to either a selected chat User or Chat Queue. 

 Click to end the current Chat call. 

 Click to Transfer the current chat call to either a selected Chat User or Chat Queue. 

 
Invite one or more chat users to join the current chat call. Invitees must accept the 
invite to join. 

 Select the chat dialogue and click the Copy button to copy to the clipboard. 

 Save a transcript of the chat conversation in a text format to a specified disk directory. 

 Click to transmit the typed text. Alternatively simply press the keyboard Enter key. 

 Close the current chat pane. 

 Add, edit or delete standard chat phrases or commonly used URL links 

 
Select saved text phrases from the drop-down list. These are sent directly to the other 
chat parties. 

 
Select saved URLs from the drop-down list. These are sent as links directly to the 
other chat parties. 

 Push your current Desktop browser URL to the chat recipients. 

 
Automatically send a seies of web page URLs as you navigate using the Desktop web 
browser. The Trace URL button toggles the feature on/off. 

 Pink - Outbound Chat conversation 

 Green - Inbound Chat conversation 
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1. Click the  button to start a new chat call. 

2. Select either the Chat User or Chat Queue option and then select the specific entry from the drop-
down list. 

3. Click the Chat button in the dialog window. A new conversation pane opens.  

4. Type in the message in the message text field, then click  or simply press the keyboard 
Enter key to transmit the typed text. An outbound chat call will be shown as waiting in the Active 
Calls pane until the recipient answers the call. 

1. Click the  button. 

2. Optionally, click the  button to save a transcript of the chat conversation in a text 
format to a specified disk directory. 

3. Click the  button to close the conversation pane. 

1. When a new chat call pop-up message is displayed: 

 Click Accept on the pop-up message to answer the 
chat call, and then navigate to the Chat pane by 
clicking on the Chat tab, or  

 Click Show Call on the pop-up message to display the  

Chat pane, and then click the  button. 

2. Type in the reply message in the message text field, then click  or simply press the 
keyboard Enter key to transmit the typed text. 

1. Click the  button to transfer the current chat call. 

2. Select a chat User or Queue from the drop-down list. Optionally check the Include current chat 
conversation box to give the recipient access to the prior dialogue.  

3. Click the Transfer button to complete the call transfer. 

 

Chat Messages provides an organised listing of chat conversations and chat users. Select the required 
category and then use the right-click menu to access the available functions for the selected chat session 
or user. Refer to the online help for more details. 

Refer to the online help for additional less frequently used functions and configuration settings. 
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Before using Console to process calls, each Operator must log in and select an Operator class.. The 
Class settings determine which Queues you answer calls for and how soon they are offered to you. 

 

 

1. To Log In: 

 Click the default action Login bar, or 

 Select Login from File menu, or 

 Type Ctrl+L (Console Hot Keys), or 

 Click the Login icon on the toolbar. 

2. Select the appropriate Class from the dropdown list. 

Click the Login icon  on the toolbar to logout of any queues. 

Note: Remember to logout out of any Operator queues before closing the Console application. 

1. To take the default break (usually 5 minutes), click on the  button 
in the toolbar. 

2. Alternately, open the drop-down list and select a break reason and 
set the required breaktime. If you need a custom reason choose 
Custom from the drop-down list and fill out the dialog box accordingly. 

3. Click on the same button to end your break. 
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When callers ring a Console indial number, the call joins an operator queue.  Calls from the Operator 
Queue(s) are delivered to any free Console operators who are logged in to take calls. 

Console lets you answer calls in several different ways. Operators can use the method they are most 
comfortable with. They can use different methods depending on the other tasks they are performing when 
a call arrives. 

When a call comes to the Operator queue, if calls are automatically delivered the call will ring on the 
operator's extension. Details of the caller will be shown in the Active Call pane. 

When an inbound Operator queue call is received: 

 It will ring on the operator's extension if 
automatic call delivery is set up.  Details of the 
caller will be shown in the Active Call pane. 

 If demand delivery is configured (non-
automatic) or there are additional calls in the 
queue, the calls are shown in the Calls Waiting 
pane. 

 

In the Calls Waiting pane, select a call. The Default Action shows Deliver Call. 

 

To deliver the call to your extension, use the mouse, keyboard, or function keys: 

 Click the Default Action button, or click the Deliver/F9 icon in the Speedbar, or. 

 Press Enter, or 

 Press F9. 

Once the call has been delivered, it is shown in the 
Active Call pane. 

 

An offering call is presented in the Active 
Call pane. The Default Action shows 
Answer Call. 

 

To answer the call, use the mouse, keyboard, or function keys: 

 Click the Default Action button, or click the Answer/F2 icon in the Speedbar. 

 Press Enter. 

 Press F2. 

Note: If the operator is using a headset and has selected Auto Answer, the call is 
automatically connected 

Operators can also answer calls ringing on other extensions. See Speed-dial functions. 

Note: If you are using a headset and you have selected Auto Answer (File menu | Preferences | 
Telephone tab), the call is automatically connected for you. 
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1. Make or answer a call 

2. Begin typing a name from the Phonebook in the 
Destination field.  The field entry will auto-
complete as you type. 

3. Press Enter once to perform a supervised transfer. 

4. Press Enter again to complete the transfer. 

Note: You can also type a phone number directly into the Destination field to transfer to an outside phone 
number or you can click on a presence button to pass a number into the destination field. 

Make or answer a call, then: 

 

 

On the Presence tab, right click on the Presence button of the person that you wish to 
transfer the call to.  

 

Select one of the following options: 

 Supervised Transfer to: The original call is placed on hold and the second party 
dialed. To complete the transfer click Complete Transfer. This will connect the two 
parties and disconnect you from the call. 

 Blind Transfer to: The original call is transferred through to the second party and 
you are disconnected from the call.  
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To select the extension to transfer the call to, open the Phonebook and double-click on a 
name or number to call it.   

 

To search for a name, you can type the name into the Phonebook Search Field. 
 
The Phonebook searches for and displays all the matches for your name. Click a name 
from the results and select the required number. 

 

To finalize the transfer: 

 click the Complete Transfer button on the Speedbar, or  

 press F3 or 

 press Enter on the keyboard. 

The call is connected to the transfer number. 

Console allows you to park a call for yourself or park it into another extension. 

Park a Call for Yourself 

With a call in the Active Call pane: 

 click the Park button on the Speedbar, or 

 press F5 on the keyboard. 

The CLI and Console Operator extension are displayed in the Parked Calls field (the longest parked call 
is automatically highlighted). 

Retrieve a Parked Call 

Select a call in the Parked Calls pane. 

 Click the Unpark button on the Speedbar, or 

 Press F5 on the keyboard. 
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Park a Call for an Extension 

Locate the Presence Button for the extension you want 
to park the call on. 

Right-click the Presence button and select 
Park for <Name> from the pop-up menu. 

The CLI (Caller) and ‘Parked for’ name are displayed  
in the Parked Calls field. 

You can make a call using Presence buttons, or by entering a name or number in the Destination field. 

Finding a Number Using Presence buttons 

1. Locate the Presence Button of the party you want to call. 

2. If the party has only one number in the Phonebook, click the 
Presence button to make the call. 

3. If the party has more than one number in the Phonebook, click 
the phone icon to see a list of alternate numbers. 

4. Click a number to make the call. 

Finding a Number Using the Destination field 

1. Type the first few letters of the party's name 
in the Destination field. 

2. If the name is found in the Phonebook, 
Console auto-completes the name and 
shows the default number and any info/notes. 

Note: The party’s Presence button will also have a blue border to facilitate location. 

3. To see other numbers, click the drop-down arrow beside the Destination field.  Select a number 
from the list then press Enter or click the default action button to make the call. 

4. You can also enter numbers in the Destination field, just as you would on a phone keypad.  For 
external calls, remember to enter any access codes (such as 1 for outside call). 

Note: If you have Quick Find enabled, you can search through similar names more quickly. 
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An Operator can perform the following administrative functions from within Console only if they have 
been granted the required security permissions via the Administrator application. 

A Mode is a set of parameters that control how and where calls are delivered, and the announcements 
that are played at different times of day. Modes can be scheduled, but the Operator can manually 
override the Mode. 

Some modes are provided by default: 

 Calls ring at the main Operator Console when Day mode is active. 

 When Night mode is active, calls may go to a Night bell, or an after hours contact number, or be 
played an after hours announcement with more contact information. 

 When Unattended mode is active, calls may go to a back-up Operator. 

 When Emergency mode is active, calls may go to an announcement, or a mobile phone. 

 

The Mode toolbar includes a button  
for each available Mode of the Operator 
queue, with the active mode indicated  
depressed. 

 

If there is more than one operator, the Operator can control the modes for each queue 
separately. 

 Click the arrow to see the modes for each queue.  

 Click a queue name to set that mode for that queue. 

Occassionally Operators will change the Presence Profiles of other persons who are shown as in the 
office when in reality they are traveling or out of the office in some way. 

1. Right-click on the users Presence 
Button. 

2. From the resulting shortcut menu choose 
Select Presence Profile and then choose 
the correct profile from the list. 
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Operators have the ability to transfer voice messages from the Operator Console.  This is most common 
when an Operator is in charge of a company mailbox where they listen to messages left overnight and 
then route them to the necessary people.  This feature must be enabled by the administrator. 

 

 
Click on the Messages tab. 

 
Select which mailbox you want to view (you must have security rights). 

 
View and/or listen to messages. 

 
Drag and drop them into a queue or other person’s mailbox. 

 

The Phonebook in Console allows you to enter 
information about internal employees or 
external customers.  You can create or edit 
entries in the Global, company or in your own 
Personal Directory depending on your security 
rights. 

From within the Phonebook you 
can enter: 

 Phone, fax, pager numbers, 
etc. 

 Email addresses 

 Special Info/Notes 
(descriptive text about that 
person) 
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Preferences allow each Operator to customize the view and behavior of Console. The available 
preference settings are grouped logically on different tabs of the dialog. 

These are some of the common options that you can change from within File menu|Preferences. 

Automatically use your default login 
class when you start Console. 

Enable the functionality provided by the 
hot keys and keyboard shortcuts. 

Choose auto-answer if you use a 
headset, to connect immediately to 
delivered calls without Operator 
intervention. 

When you transfer a call, do you want 
to speak with the receiving party before 
you transfer the call (i.e. Supervised or 
Executive transfer) or do you want to 
transfer the call automatically without 
speaking to the receiving party. 

Enable Quick Find to search for and  
select contacts, based on an entry in the 
Destination field. 
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